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Technical Support 
PowerSuite Professional technical support is only available to registered PowerSuite Professional users, therefore 
complete your registration card and return it to the support department at the below address as soon as possible. 
 
Megger Technical Services 
3 Park Farm Business Centre 
Fornham St Genevieve 
Bury St Edmunds, Suffolk 
England 
IP28 6TSS 
 
PowerSuite Professional technical support is available in the following ways: 
 
T +44 (0)1284 762 426 (Mon- Fri, 09:00 to 17:30) 
F +44 (0)1284 755 131 
E mts@megger.com 
 
Software updates can also be found on the www.mtsforum.com website. 

 

Before contacting technical support, please refer to all written documentation and online help. Please be near your 
computer if possible and be prepared to provide the following information: 
 
1. The first six characters of your registration number, eg. PSDEMO. (Available from the ‘About’ option on the main 

‘Help’ menu.) 
2. Software version number, also available from the ‘About’ screen. 
3. Any relevant error messages and codes. 
4. The steps taken and operations performed leading up to the problem. 
 

 
Recommended System Requirements 

• PC with pentium III class processor (Pentium IV processor recommended for NICEIC computer friendly forms) 

• Microsoft Windows™ XP operating system 

• 128MB of RAM (256MB recommended for NICEIC computer friendly forms) 

• 100MB of free hard disk space for a typical installation 

• CD-ROM drive. 

• VGA or higher-resolution monitor; minimum 800 x 600 resolution 

• Microsoft Mouse or compatible pointing device. 
 
Recommended System Requirements (Mobile Device) 

• Windows mobile 2005 operating system 

• 64MB of RAM 

• Docking cradle or USB cable 

• Microsoft ActiveSync synchronization software 

• 50MB of free hard disk space on PC for Ultra Mobile installation 

• Integrated Bluetooth or Bluetooth adapter (for Megger MFT1553 real time result capture) 
 



Installation – Stage 1 
N.B. please close all Windows programs before installing as any running programs may stop critical files 
from being installed correctly and result in an incomplete installation. 
 
If the CD does not auto run when inserted, you will have to manually run the Setup.exe program from your CD-ROM 
drive. (e.g. “D:\Setup.exe”) The following screen will be displayed: 

 
Follow the installation prompts and accept the default values where possible. 
 
Registration 
During the installation you will be prompted to enter your name, company name and the 16-digit registration number 
from the registration card included with the software. 

 
The next screen will prompt you to complete your Ultra Mobile registration number if applicable. 
 
N.B. Please complete and return your registration card to Megger Technical Services as soon as possible to 
receive telephone support and software updates. 
 
Installation – Stage 2 
Once your machine has been restarted, the second stage installation will install Megger Download Manager onto 
your machine.  It is recommended you select all the default options for the download manager installation. 
 
The download manager program will run automatically once it has been installed and you will be presented with a list 
of supported test instruments to install. 

 
When you close the download manager program, the remaining installation steps will be carried out. 

 
 

Running PowerSuite Professional 
To start Megger PowerSuite Professional: 

1. From the windows Start menu , select PowerSuite Professional from the Programs|PowerSuite 
Professional group. 

 
Type ‘Supervisor’ in the ‘User ID’ field on the Login screen and click the ‘Start’ button to run the software. 
 
Setup Wizard 

The first time that you run the software, the setup wizard will guide you through creating your own  company 
contact. 

  

The registration number should be 
entered in one string with no spaces or 
dashes. To help identify numbers they 
will be underlined on the registration 
card. Your registration number will be 
validated on the second stage of the 
installation procedure. 

Select the test instruments you currently use and click 
the Add Driver button to install the driver(s) into 
Download Manager. (Hold down the Ctrl key and click to 
select more than one instrument) 

Once the 'Installation 
Completed.' message has been 
displayed at the bottom of the 
install screen it will disappear 
and you can run the software. 



You will then be prompted to select a certificate header page to append to the front of any certificates you generate. 

 
The setup wizard will also prompt you to enter details of personnel and set up lists of test instrument serial numbers. 

  
(Personnel and instrument serial numbers will be available as drop down lists when editing certificates) 
 
You can add and amend the personnel and test instrument lists using the ‘List Editor’ program that is available from 
the ‘Programs’ menu in the PowerSuite shell. 
 
Once the setup wizard has been completed, you can continue with Basic Operation sections for either PAT or 
BS7671. 
 

Basic Operation: PAT  and BS7671 
PowerSuite Professional works in conjunction with the Megger PAT4 test instrument to produce portable appliance 
testing certificates in a variety of styles. 
 
Program Flow 
The recommended operating procedure is as follows. 
1. Run the Contact Wizard to set up your clients and locations. 
2. Select Locations you wish to send (Upload) to the PAT4.(PAT Only) 
3. Upload to the PAT4*. (PAT Only) 
4. Test appliances storing the results then return to the computer .(PAT Only) 
5. Run the Download Wizard to transfer the data from the PAT4 into PowerSuite. .(PAT Only) 
6. Assign the Data to its relevant Location. (if you have a database version of the software) .(PAT Only) 
7. Run the Certificate Wizard to create a certificate and select the results Datablock you wish to use . 
 
* N.B. The Upload process will erase all data already existing on the PAT4. If you are already using a PAT4 
you will need to download it first using the Download Wizard before you commence with the recommended 
operation procedure. 
 

Contact Wizard  

The PAT4 contains a one-to-many relationship between  client and  location contacts.  Click the  contact 
wizard button to set up new client and location contacts in PowerSuite.  

  
Follow the screen prompts ensuring that you first select to add a ‘CLIENT’ contact. Once the ‘CLIENT’ contact has 
been added you will be prompted to add ‘LOCATION’ contacts against it. Ensure that each client is added to the 

contact tree under your  ‘COMPANY’ contact. 
 
Select Locations 
This step involves dragging the locations you require uploaded to the 
PAT4 driver in the Download Manager window. 
To select a location to upload 

1. Click on the  location icon next to the location name 
2. Drag the icon over the ‘MEGGER PAT4’ name in the Download 

Manager window. 
3. Release the mouse button. 
4. Click continue on the data selection screen. 
5. An ‘Upload Me’ file will be created in the PAT4 ‘Inbox’. 
 

Click the ‘View Certificate 
Headers’ button to view the 
available header styles. 
 
Select the ‘No Header’ option 
if you do not want a certificate 
header page. 



Upload to the PAT4  

Before you upload ensure you have the correct cable attached between the PC and the PAT4 and the PAT4 is 
switched on. 

Click once on the  item in the download manager window, and then click the small  upload 
button on the toolbar. 

  
Select the ‘Upload Me’ file to upload and click the ‘Open’ button. When the ‘MEGGER PAT4 Upload’ screen is 
displayed follow the prompts by selecting ‘Comms’ on the PAT4 followed by ‘Receive’ to start the upload. 
 
* N.B. The Upload process will erase all data already existing on the PAT4. You will receive a confirmation 
message on the PAT4 before the data is erased. 
 

Download Wizard  

The download wizard will transfer the test results from the PAT4 and create a new file in the PAT4 ‘Inbox’ in the 
download manager window. Before you download ensure you have the correct cable attached between the PC and 

the PAT4 and the PAT4 is switched on. Click the  download wizard button and follow the prompts to display the 
‘MEGGER PAT4 Download’ screen. Once this screen is displayed select ‘Comms’ on the PAT4 followed by ‘Send’ to 
start the download. 

         
A new download file will be created in the ‘MEGGER PAT4’ ‘Inbox’. The date and time stamp will be used as the file 
name. 
 
After the download from a MEGGER PAT4 ONLY has finished the Wizard will ask if you would like to create contacts 
from a MEGGER PAT4 Download File.  If you select yes you can select which Clients/Locations you would like to 
create. Select these and click ‘Next’.  The contact tree will be updated and new Clients and Locations inserted in 
alphabetical order. 
 
When you click next  will see a list of all the available download files. This list will include files in the 'Inbox' and the 
'Kept' folder for the specified instrument. 

    
When the download file has been selected the required conduit file will be loaded and the data will be processed. 
Once the database has been updated a new unassigned contact will be created containing the assets and test 
results.   Click the 'Finish' button to end the format wizard. Once the unassigned data has been created the next step 
is to link or 'Assign' it to a contact or contacts. Once the data has been assigned the unassigned reference will be 
removed and the data will be available as a data block for the creation of certificates. 
 
When you click on Finish the Assign tab will be active and the formatted files will be ready to Assign. 
 

Certificate Wizard  

The certificate wizard is used to create new certificates and to import 
selected test results from the PAT4. Before you create a new 
certificate, ensure that you highlight the correct location contact in the 

contact tree by clicking on it . 
 

Click the  certificate wizard button and select the style of 
certificate you require. You will then be prompted to select the 
datablock file to populate the certificate.  



You will be prompted with the next available certificate number and identity for this type of certificate and you can 
accept or override these.  You will also be prompted to automatically create an appointment for the appliances next 
test date. 
 
The certificate will be loaded complete with all the test data selected. The certificate may have more than one page 

and you can easily switch between pages using the  page controls. Complete the certificate by selecting 
the PAT4 serial number and tester name from the drop down lists. The certificate can be printed at any time by 

clicking the print  button. 
 
 
Editing Existing Certificates 
To load an existing certificate, highlight the location contact and select the ‘Edit/View an Existing Certificate’ tab. 

  
Double click on the ‘Appliance Testing’ folder to display all the certificates for the selected contact. Double click on 
the required certificate to load it back in where it can be reviewed edited and re-printed. 
 
 

 

Installing Ultra Mobile 

With PowerSuite running, click the large ‘Mobile’ button on the PowerSuite toolbar to load the Ultra Mobile 
Module. 

The Mobile Device installation Wizard should start automatically: 
 
If the Mobile Device Installation Wizard does not automatically start, select 
‘Install Software on Mobile Device’ from the Options menu 
 
The Mobile Device Installation Wizard will ask you to select the type of 
Mobile Device you intend to use. 
 
Select the required device and click the ‘Next’ button. 
 
The next screen will ask if this is a new installation on this mobile device or 
if you are updating the software on the device. 
 
The default prompt will be for a new installation. Click the ‘Next’ button and 
then follow the instructions below for the type of device you are installing 
onto. 
(Windows Mobile, Smartphone, Symbian S60 V3)  If you select 

‘Windows Mobile’, ‘Smartphone’ or ‘Symbian S60 V3’ the following prompt will be displayed: 
 
Ensure the Mobile Device is connected and Microsoft ActiveSync is running before clicking the ‘Next’ button to start 
the software installation. 
 
The Ultra Mobile software will be installed on the Mobile Device. Once the software installation has completed, you 
will be prompted to check the mobile device screen. 
 
N.B. The installation may take a few minutes. 
 
You may be required to initiate the Ultra Mobile software installation on the device. Once the Ultra Mobile installation 
has completed, click the ‘OK’ button. 

 
Once the software has been successfully installed you will be prompted 
to register a unique user id with PowerSuite. 
 
Click the ‘Next’ button to display a prompt screen with an entry field for a 
user id. 
 
The user id you enter here is very important and the Ultra Mobile Module 
will use it to link specifically with the device you have installed the 
software onto. As it is possible to install the Ultra Mobile software onto 
multiple devices if you are licenced to do so, each user will have their 
own synchronising settings. The user id could be entered to identify the 
specific mobile device or it could be the name of an engineer. Once you 
have entered your unique user id click the ‘Next’ button. 
 
You will be prompted to click the ‘Next’ button to register the user on the 
device. Once the user has been registered the following screen will be 
displayed: 
 



Click the ‘Finish’ button and continue with Step 4. 
 
There will also be a status of ‘Not Synced’ against the Last 
Sync Date. This status will be updated once you have uploaded 
your selected certificate templates in the next step. 
 
You now need to synchronise with the device using the Ultra 
Mobile Module and upload the required certificate templates. 
The following template maintenance screen may be loaded 
automatically, otherwise click the  

 
‘Synchronise’ button on the Ultra Mobile Module toolbar 
.The following template maintenance screen should be 

displayed. 
 
 
 
 
 
 

 
Scroll up and down the list to view all the available certificate 
templates. Double click on the required certificate template 
name to change the status from ‘No’ to ‘Yes’. Any templates 
with a status of ‘Yes’ will be uploaded to the Mobile Device. 

Click the ‘Ok’ button to close the 
template maintenance screen. The selected templates will 
be automatically uploaded to the device. 
 

 
 
Ultra Mobile - Basic Operation 
 
The Ultra Mobile software has been designed to be flexible in it’s operation. Certificates can be generated in 
PowerSuite and transferred to Ultra Mobile via local synchronisation, removable media or email, or new certificates 
can be created from scratch on your Mobile Device and transferred back to PowerSuite for final certification. 
 
The following section assumes that you have already completed the necessary steps to set up your clients and 
locations in PowerSuite and you are familiar with the basic operation of creating new certificates. 
 
Standard Operation - Synchronisation 
 
This method of operation involves a direct connection between PC and Mobile Device via a USB cable or cradle. 
 
Method 1 
 
1. (PC) Run the Certificate Wizard in PowerSuite to create a new 
Installation Testing certificate for  your selected location. 
 
First highlight the correct location in the contact tree and click the large  
Certificate Wizard button . When you are prompted to select the type of 
certificate be sure to select ‘Installation Testing’. Complete the remaining wizard prompts finally selecting the 
certificate number, then click the ‘Finish’ button to create the certificate and display it on screen. 
 
You can part complete any data fields on the certificate before closing it and returning to the Certificate Manager 
screen. 
 
2. (PC) Export the certificate to the Ultra Mobile Module. 
 
To export the certificate you have created to the Ultra Mobile Module first ensure you have the ‘Edit/View an Existing 
Certificate’ tab highlighted in the certificate manager in PowerSuite and you also have the correct location 
highlighted. Right click on the certificate you wish to export to display a pop up menu. 

 
Select the 'Export Certificate to Mobile Device' option from 
the pop up menu, and then select the Device User Name 
from the next pop up menu. 
 
Select ‘Yes’ to the confirmation prompt to upload to the Ultra 
Mobile Module. 
 
N.B. Once the certificate has been exported from PowerSuite 
into the Ultra Mobile Module it will be locked and cannot be 
edited in PowerSuite. 



3. (PC) Load the Ultra Mobile Module and check the certificate is in the Mobile ‘Outbox’ ready to be 
synchronised with the Mobile Device. 

You can now load the Ultra Mobile Module by clicking the large ‘Mobile’ button on the PowerSuite toolbar.  
 
Once the module has loaded, ensure the required User Name is selected from the drop down list, and click the 
‘Outbox’ tab.  

 
You should see your certificate in the ‘Outbox’ ready 
to be synchronised with the Mobile Device. 
 
4. (PC) Ensure the device is connected to the PC 
via a USB cable or docking station and the Ultra 
Mobile program is NOT running. 
 
5. (PC) Synchronise from the Ultra Mobile Module 
to transfer the certificate to Ultra Mobile. 
 
Click the ‘Synchronise’ button on the Ultra Mobile 

Module toolbar . and the certificate will be 
transferred from the Ultra Mobile Module ‘Outbox’ to 
Ultra Mobile. Once the certificate has been 
transferred you can close the Ultra Mobile Module.  
N.B. Pressing F5 will refresh the ‘Outbox’, this is 
necessary if the Ultra Mobile Module is open when a 

certificate is exported from PowerSuite. 
 
6. (Mobile Device) Run the Ultra Mobile program on the device and load and edit the certificate as required. 

 
To start the Ultra Mobile program on a Windows Mobile PDA, open the Programs folder and click the 
‘Ultra Mobile’ icon . To start the Ultra Mobile program on the Palm, open the ‘All’ category and click 
the 'Ultra Mobile’ icon. 

 
To start the Ultra Mobile program on a Windows Mobile 5 SmartPhone, click the‘Ultra Mobile’ icon from the Start 
menu. 
 
To start the Ultra Mobile program on a Symbian S60 device, open the ‘Installations’ folder from the main Symbian 
start screen and click the‘Ultra Mobile’ icon. 
 
The Ultra Mobile welcome screen will be displayed  for 2 seconds and 
you can click or tap the screen to load the program. (You can switch off 
the welcome screen from the Preferences menu) 
 
Like PowerSuite, the Ultra Mobile software has a simple to use built in 
certificate manager. The certificate manager defaults to the ‘Open 
Certificate’ screen but can easily be switched from the File menu to 
create new certificates. 
 
The certificate you exported from PowerSuite will be displayed and you 
can highlight it and click or tap on the certificate name to load it. 
 

 
 
 
 
 
 
 
The certificate pages will be loaded and the first page of the certificate will 
be displayed ready for editing. The top two rows show the current page and 
section 
 
You can move between pages in three ways. Clicking on the current page 
name will show a drop down list selection of the available pages in the 
certificate .  
 
 
 
 
 
 

 
 



 
Tap or click on the page you wish to load. You can also tap or click on the 
Options menu at the bottom right of the screen and select ‘Select PageJ’ .  
Alternatively you can use the left and right navigation controls on your mobile 
device to move between pages. 
 
All pages are split up into sections where possible to help make data entry 
easier. The program defaults to showing the first section when loading the 
page, but this can be changed to default to (All Sections) in the preferences.  
 
 
 
 
 
 
 
 
 
 
 

 
You can move between sections on a page in three ways. Clicking or tapping on the current section name will show a 
drop down selection of the available sections on the page . Tap or click on the section you wish to load. You will also 
have the option of displaying (All Sections) on the page. You can also tap or click on the Options menu at the bottom 
right of the screen and select ‘Select SectionJ’ .  Alternatively if you use the up and down navigation controls on 
your mobile device you will see the section change automatically as you navigate beyond the last/first field in the 
section. 

 
The main area of the screen is divided into a two-column grid with 
labels in the left hand column and space for entering data in the right 
hand column.  
 
You can enter data by clicking in one of the fields in the right hand 
column and using one of 
the available input 
methods on the mobile 

device to enter text. Some of the data entry fields will contain drop down 
lists.  
 
If a field has a list available you will see a small drop down arrow at the 
right hand edge when the field is being edited. Tapping or clicking on this 
arrow will display the drop down list in the grid. You can scroll up and 
down the list and tap or click to make a selection. You can also see the 
drop down list full screen by clicking the button when the field is being 
edited.  
 
 
The current selected list item will be highlighted and you can scroll up 
and down and tap or click to select an item from the list. If you select the 
Back option from the menu, the list selection will be cancelled and you 
will be returned to the grid. You also have the option of entering data 
manually for these fields if you do not want to select an item from the list. 
 
Some fields are defined as date input fields. If you click on one of these 
types of fields a date selector will be displayed.  
 
Once you have selected the required date tap or click on the ‘OK’ menu option to return to the certificate entry 
screen. 
 
Some fields allow you to enter more than one line of text. When you click on one of these multi-line input fields a 
multi-line text input screen will be displayed.  
 
Once you have entered all the text in a multi-line input field tap or click on the ‘OK’ menu option to return to the 
certificate entry screen. 
 
Once you have finished editing the certificate, select the ‘Close Certificate’ option from the File menu to return to the 
certificate manager screen. 
 
 
 
 
 
 
 
 



7. (Mobile Device) Mark the certificate as completed in the Ultra Mobile software. 
 
You can continue to edit and make changes to the certificate as required. 
Once you have finished editing and wish to transfer the certificate back to 
PowerSuite you will need to alter the status of the certificate in the Ultra Mobile 
certificate manager. 
 
The ‘Status’ column in the certificate manager has three states for each 
certificate, <blank> (work in progress), 'Sync' (ready for synchronisation), and 
'Export' (transfer to removable media or email). Tap or click on this status 
column to set it to 'Sync', and ready for transferring back to PowerSuite. 
 
Close the Ultra Mobile software by selecting ‘Exit’ from the File menu in the 
certificate manager. 
 
 
8. (PC) Ensure the Mobile Device is connected to the PC via a USB cable 
or docking station ready to be synchronised. 

 
Load the Ultra Mobile Module by clicking the large ‘Mobile’ 
button on the PowerSuite toolbar . 
 
Ensure that the required User Name is selected from the 
drop down list, and select the 'Inbox'. Click the ‘Synchronise’ 

button on the Ultra Mobile Module toolbar . 
 
The certificate will be transferred from the Mobile Device 
back into the ‘Inbox’ in the Ultra Mobile Module. 
 
 
The certificate is now ready to be imported back into 
PowerSuite. 
 
 

 
9. (PC) Import the certificate back into PowerSuite from the Ultra Mobile Module. 
 

Click on the ‘Transfer Certificate’ button and the certificate will be moved from the Ultra Mobile Module back to 
the correct location in PowerSuite. 
 
Close the Ultra Mobile Module and press the F5 button to refresh the PowerSuite Certificate Manager. The original 
certificate will be unlocked and can be edited and printed as required. 
 
Method 2 
 
This method describes a new certificate being generated on the Mobile Device. 
 
1. (Mobile Device) Run the Ultra Mobile software on the Mobile Device and create a new certificate from one 
of the available templates. 
 
With this method of operation the first step is to create a new Installation Testing certificate on the Mobile Device by 
selecting one of the available templates.  
 
To start the Ultra Mobile program on a Windows Mobile PDA, open the 
Programs folder and click the ‘Ultra Mobile’ icon. To start the Ultra Mobile 
program on the Palm, open the ‘All’ category and click the 'Ultra Mobile’ 
icon. 
 
To start the Ultra Mobile program on a Windows Mobile 5 SmartPhone, 
click the‘Ultra Mobile’ icon from the Start menu. 
 
To start the Ultra Mobile program on a Symbian S60 device, open the 
‘Installations’ folder from the main Symbian start screen and click 
the‘Ultra Mobile’ icon. 
 
The Ultra Mobile welcome screen will be displayed for 2 seconds and you 
can click or tap the screen to load the program. (You can switch off the 
welcome screen from the Preferences menu) 
 
Like PowerSuite, the Ultra Mobile software has a simple to use built in 
certificate manager. The certificate manager defaults to the ‘Open 
Certificate’ screen but can easily be switched from the File menu to create new certificates. 
 



Select the ‘New CertificateJ’ option from the File menu. A list of the available certificate templates will be displayed. 
Tap or click on the required template to create and load a new certificate. 
 
The certificate pages will be loaded and the first page of the certificate will be displayed ready for editing. 
 
2. (Mobile Device) Edit the new certificate in the Ultra Mobile software. 
 
Refer to steps 6, 7 and 8 in Basic Operation Method 1 for information on editing, marking the certificate as 
completed and synchronising with PowerSuite. 
 
3. (PC) Import the certificate back into PowerSuite from the Ultra Mobile Module. 
 

Click on the ‘Transfer Certificate’ button and the certificate will be moved from the Ultra Mobile Module to the 
‘(PDA Unassigned)’ contact in PowerSuite. 
 
4. (PC) Move the certificate from the ‘PDA 
Unassigned’ contact to the correct 
PowerSuite location. 
 
Close the Ultra Mobile Module and press the F5 
button to refresh the PowerSuite Certificate 
Manager.  
 
The ‘(PDA Unassigned)’ contact is 
automatically created under the ‘(Unassigned 
Contact)’ at the top of the contact tree and this 
is a temporary storage location for certificates 
and data that is not tagged to a specific location.  
 
You can move the certificate from the ‘(PDA Unassigned)’ contact by dragging it over the required location in the 
contact tree and releasing the mouse. You can then finish editing and printing the certificate. 
 
 
 
 

 


